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In questo manuale...
Questo manuale spiega come installare il software della ChemStation, come 
aggiungere altri moduli per gli strumenti, come configurare il sistema analitico 
e come verificare che l'installazione e la configurazione siano complete 
e funzionanti.

I capitoli inclusi in questo manuale sono:

1 - Preparazione all'installazione - In questo capitolo viene fornita una 
panoramica della ChemStation di Agilent Technologies. Sono elencati 
i requisiti per il PC, per l'aggiornamento e le informazioni relative alle 
comunicazioni con gli strumenti.

2 - Installazione della ChemStation Agilent - Questo capitolo illustra le 
procedure per l'installazione e l'aggiornamento del software della 
ChemStation Agilent. 

3 - Configurazione degli strumenti - Questo capitolo descrive come 
utilizzare Configuration Editor per configurare gli strumenti.

4 - Validazione e avvio della ChemStation Agilent - Questo capitolo 
descrive come verificare e iniziare a utilizzare il software ChemStation 
Agilent.

5 - Risorse supplementari - Questo capitolo fornisce una panoramica sulle 
risorse aggiuntive della ChemStation Agilent reperibili nel DVD della 
ChemStation Agilent e in Internet.

In questo manuale si presume:

• Che l'utente abbia familiarità con i sistemi operativi Microsoft® Windows 
XP Professional o Microsoft® Windows Vista™ Business.

• Che il software venga installato su un PC con i requisiti hardware minimi 
specificati.

• Che gli strumenti e i dispositivi di comunicazione siano compatibili con 
questa versione della ChemStation Agilent.

Il software della ChemStation Agilent comunica con apparecchiature 
analitiche tramite LAN (Local Area Network) o GPIB (General Purpose 
Interface Bus).
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1 Preparazione all'installazione

Requisiti per il PC

I requisiti hardware minimi per il software della ChemStation di 
Agilent Technologies (versione B.04.02) sono:
• Personal computer con processore Intel Pentium IV  

(1.5 GHz per Microsoft Windows XP Professional) 
(3.4 GHz [singolo componente principale] per Microsoft Windows Vista)

• Monitor con risoluzione SVGA 1280 × 1024, 16 mila colori o superiore

• Disco rigido da 40 GB (Microsoft Windows XP Professional), disco rigido 
da 160 GB (Microsoft Windows Vista)

• Unità DVD

• RAM da 512 MB (Microsoft Windows XP Professional), 1 GB (Microsoft 
Windows Vista)

• Dispositivo di puntamento compatibile con Microsoft Windows

• Stampante compatibile con il sistema operativo. Per il sistema in lingua 
inglese, stampante PCL 5c, 5e, 5e, 5.02 o 6, per un sistema in lingua cinese, 
stampante PCL 6, per un sistema in lingua giapponese, consultare la Tavola 1.

• Sistema operativo Microsoft Windows XP Professional (Service Pack 3) 
o Microsoft Windows Vista Business (Service Pack 1) (solo inglese, 
cinese e giapponese). 

• Supporto per il protocollo TCP/IP installato, se si utilizzano comunicazioni LAN

• Per le comunicazioni GPIB, utilizzare l'adattatore GPIB USB 82357B 
o la scheda GPIB PCI 82350B e l'I/O Library Suite 15.0. Per istruzioni 
sull'installazione di Agilent I/O Library Suite, fare riferimento alla 
directory dei manuali nel DVD della ChemStation.

Tutto l'hardware del PC e le periferiche devono essere riportati nell'elenco 
di compatibilità hardware di Microsoft (HCL) disponibile nella home page 
di Microsoft all'indirizzo http://www.microsoft.com. Se l'hardware del PC 
non è presente nell'elenco HCL, è possibile che il sistema non funzioni 
correttamente con il software della ChemStation Agilent.

Computer non HP

La ChemStation Agilent è progettata per funzionare correttamente con 
un'ampia gamma di personal computer compatibili, dotati di accessori 
e periferiche che rispondono agli standard di programmazione Intel per 
piattaforme PC e per i sistemi operativi Microsoft Windows. 
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Tuttavia, Agilent ha collaudato il software della ChemStation Agilent 
principalmente su unità Hewlett-Packard (HP)/Compaq. La configurazione 
standard dell'interfaccia GPIB, ad esempio, può provocare conflitti con 
la configurazione di memoria di computer non HP. Schede di interfaccia 
accessorie aggiuntive possono causare incompatibilità con le risorse correlate 
all'hardware (porte di I/O, parametri di interrupt e canali DMA). 

Se si utilizzano computer non HP, è consigliabile usare il programma 
di impostazione fornito dal produttore per configurare il computer. 
Controllare la documentazione fornita con il computer e gli accessori per 
eliminare conflitti di risorse durante la procedura di impostazione del PC, 
in particolare durante la configurazione dell'interfaccia GPIB.

Stampanti compatibili con la ChemStation Agilent

La ChemStation Agilent è progettata per funzionare con stampanti compatibili 
con il sistema operativo in uso. Le stampanti devono essere collegate a una 
porta locale (preferibilmente parallela) o a una porta collegata in rete sul PC. 
Le stampanti a porta seriale sono supportate dal sistema operativo ma 
possono presentare notevoli limiti di prestazioni. Le stampanti in rete devono 
essere condivise tramite un server di rete che utilizza un protocollo di rete 
supportato dal sistema operativo Microsoft. È consigliabile utilizzare 
stampanti in grado di interpretare un linguaggio a codici di escape 
(ad esempio PCL) o un linguaggio di descrizione della pagina (ad esempio 
PostScript®). Le stampanti basate su host (ad esempio stampanti GDI o PPA) 
impongono un carico maggiore di elaborazione sulla CPU e non sono 
consigliate per le sessioni in linea della ChemStation Agilent. 

Per ottenere risultati di stampa ottimali con la ChemStation Agilent, utilizzare 
stampanti HP LaserJet (vedere la Tavola 1). Se la quantità di documenti da 
stampare è limitata, è possibile utilizzare anche stampanti HP DeskJet ad 
alte prestazioni. Per ulteriori informazioni sulle versioni consigliate dei driver 
per stampanti, consultare i file readme.txt. Agilent Technologies non ha 
collaudato tutte le combinazioni di stampanti e driver supportate in ambiente 
Windows. I risultati e le prestazioni di stampa possono variare con stampanti 
di altri produttori.
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Tavola 1 Stampanti collaudate con esito positivo sulla ChemStation Agilent B.04.02

Stampante Modello Driver

HP LaserJet 4050 e 4100 Driver HP PCL 5e o PCL 6

HP LaserJet 4200 Driver HP PCL 5e o PCL 6

HP LaserJet 4250 Driver HP PCL 6

HP LaserJet P3005D Driver HP PCL 6

HP Color LaserJet 2500TN Driver HP PCL 6

HP OfficeJet Pro K550DTWN Driver HP PCL 3

HP OfficeJet Pro K5400

HP LaserJet 2200D Driver HP PCL 5.02 o PCL 6

HP LaserJet 2300DN Driver HP PCL 5e o PCL 6

HP LaserJet 2420D Driver HP PCL 6
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Informazioni sulla LAN

Il software della ChemStation Agilent si serve del protocollo TCP/IP che deve 
essere installato come protocollo di rete sul PC. 

Se si controlla un sistema Agilent 6890 Plus, 6890A o 35900E, le schede JetDirect 
J4100A e LAN G1369A utilizzate per collegare tali strumenti analitici a una LAN 
richiedono il protocollo di bootstrap (BootP). Agilent supporta solo il Servizio 
BootP Agilent, disponibile sul DVD della ChemStation.

La versione B.04.02 del software della ChemStation Agilent fornisce il 
controllo dello strumento basato su LAN e l'acquisizione dati per i controller 
A/D e GC Agilent abilitati per la LAN. È possibile controllare e monitorare 
facilmente gli strumenti collegandoli a una LAN in cui risiede il PC della 
ChemStation Agilent. Il PC può essere dislocato anche a 100 metri di distanza 
dagli strumenti controllati, purché sia connesso a una LAN autonoma 
supportata da Agilent, oppure in qualsiasi parte del mondo se connesso a una 
rete TCP/IP supportata dall'amministratore di rete.

Ogni ChemStation Agilent può supportare fino a 4 strumenti sulla LAN. 
Ogni dispositivo nella LAN richiede un indirizzo IP esclusivo, una subnet 
mask e un gateway predefinito.

Se si esegue l'installazione della ChemStation Agilent sulla LAN di un sito, 
contattare l'amministratore della LAN.

La ChemStation Agilent supporta strumenti e PC con indirizzi autoassegnati, 
fissi o assegnati dal Servizio BootP Agilent (vedere "Installazione del Servizio 
BootP Agilent" a pagina 17). DHCP non è supportato da Agilent.
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Comunicazione tra gli strumenti

La ChemStation Agilent comunica con i GC tramite una LAN o un'interfaccia 
di comunicazione GPIB (General Purpose Interface Bus).

Prima di utilizzare il sistema, è necessario impostare il canale di 
comunicazione tra lo strumento e il PC. 

Per i dettagli sull'installazione di una scheda LAN nel PC o negli strumenti da 
controllare con la ChemStation Agilent, consultare la documentazione allegata 
alla scheda LAN.

ComunicazioniLAN

Per informazioni sulle impostazioni del software e dell'hardware richiesti per 
le comunicazioni in base al sistema in uso, fare riferimento ai numeri di 
pagina riportati nella Tavola 2.

Tavola 2 Interfacce di comunicazione LAN supportate dalla ChemStation Agilent 

Tipo di strumento Modello
Revisione firmware 
supportata

Metodo di 
indirizzamento 
IP supportato

Consultare 
la sezione:

7890A G3440A A.01.10.1 Impostato nel GC pagina 14

6890N GC G1530N/ 
G1540N

N.06.05 per 7693A o 
N.05.06  
(predisposizione LAN 
04.7B3)

Impostato nel GC pagina 15

6890 Plus, 6890A G1530A/ 
G1540A

A.03.08 Servizio BootP 
Agilent

pagina 20

GC 6850  
SN ≥ US10243001

G2630A N.06.03 per 7693A o 
A.05.04 
(predisposizione LAN 
04.7B3)

Impostato nel GC pagina 16

GC 6850  
SN ≤ US00003200

G2630A A.03.05 per 7693A o 
A.03.03

Impostato nel GC o  
Servizio BootP 
Agilent 

pagina 16 
pagina 20

35900E 35900E E.01.02 Servizio BootP 
Agilent

pagina 20



Preparazione all'installazione 1

Installazione della ChemStation 13

Comunicazioni GPIB

Gli strumenti analitici che comunicano con la ChemStation Agilent tramite 
GPIB richiedono l'installazione di una scheda GPIB sul computer. Consultare 
la Tavola 3 per un elenco dei tipi di strumenti che usano la comunicazione 
GPIB insieme alla scheda di interfaccia 82350B supportata e all'interfaccia 
GPIB USB 82357B.

Per i dettagli sull'impostazione dell'hardware GPIB, vedere "Installazione 
e configurazione della scheda di interfaccia GPIB Agilent" a pagina 25. Per i 
dettagli sull'installazione e l'impostazione di Agilent IO Libraries Suite 15.0, 
vedere le istruzioni di installazione e configurazione presenti nel DVD della 
ChemStation all'interno della cartella Support\Manuals\Installation.

Tavola 3 Compatibilità GPIB e hardware analitico 

Tipo di strumento Modello Revisione firmware supportata
Agilent
82357B

Agilent 
82350B

6890 Plus, 6890A G1530A/ 
G1540A

A.03.08 Sì Sì

5890 Series II 5890 A.03.02 Sì Sì

4890D G2690A A.01.01 Sì Sì

7890A No No

6850 No No

6890N No No

35900E No No
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Impostazione degli indirizzi IP sul GC

In questa sezione viene descritto come utilizzare la tastiera di un sistema GC 
per impostarne l'indirizzo IP. Per i GC che non supportano tale funzione, 
vedere "Installazione del Servizio BootP Agilent" a pagina 17.

Configurazione dell'indirizzo IP per Agilent 7890A GC

Questa procedura fa riferimento al sistema Agilent 7890A GC.

1 Sulla tastiera del sistema 7890A, premere Options (Opzioni). Scorrere fino a 
Communications (Comunicazioni) e premere Enter (Invio). Viene visualizzata 
la seguente finestra:

COMMUNICATION SETPTS 
---- LAN ---- 
IP: 000.000.000.000 
GW: 000.000.000.000 
SM: 000.000.000.000 
Enable DHCP OFF 
Reboot GC 
Mac Address

2 Immettere i numeri dell'indirizzo IP del sistema 7890A GC, separati da 
punti, quindi premere Enter (Invio).* Il sistema GC visualizza un messaggio 
che invita a spegnere e riaccendere lo strumento. Non eseguire subito lo 
spegnimento e la riaccensione. Premere Clear (Cancella).

3 Scorrere fino a GW. Immettere il numero di gateway e premere Enter (Invio). 
Il sistema 7890A visualizza un messaggio che indica di spegnere e 
riaccendere lo strumento. Non eseguire subito lo spegnimento e la 
riaccensione. Premere Clear (Cancella).

4 Scorrere fino a SM e premere Mode/Type (Modo/Tipo). Scorrere fino alla 
subnet mask appropriata nell'elenco dei modi e premere Enter (Invio). Il 
sistema 7890A visualizza un messaggio che indica di spegnere e riaccendere 
lo strumento. Non eseguire subito lo spegnimento e la riaccensione.

5 Scorrere fino a Reboot GC (Riavvia GC) e premere On/Yes (Accensione/Sì) 
per spegnere e riaccendere lo strumento e applicare le impostazioni LAN 
alla scheda.

* Se non si conoscono i valori per l'indirizzo IP, il gateway o la subnet mask per il computer della 
ChemStation, Agilent consiglia di impostare l'indirizzo IP PC predefinito su 10.1.1.100, il GC o il 
modulo di controllo A/D su valori compresi tra 10.1.1.101 e 10.1.1.105, il gateway predefinito su 
10.1.1.100 e la subnet mask predefinita su 255.255.255.0.
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6 Premere Options (Opzioni). Scorrere fino a Communications (Comunicazioni) 
e premere Enter (Invio). Controllare che siano presenti le impostazioni 
corrette.

Configurazione dell'indirizzo IP per Agilent 6890N GC

Questa procedura fa riferimento al sistema Agilent 6890N GC (con 
predisposizione LAN).

1 Sulla tastiera del sistema 6890N, premere Options (Opzioni). Scorrere fino a 
Communications (Comunicazioni) e premere Enter (Invio). Viene visualizzata 
la seguente finestra:

COMMUNICATION SETPTS 
---- LAN ---- 
IP: 000.000.000.000 
GW: 000.000.000.000 
SM: 000.000.000.000 
Enable DHCP OFF

---- RS-232 ----

2 Immettere l'indirizzo IP per il sistema 6890N. Immettere i numeri separati 
da un punto e premere Enter (Invio).* Il sistema GC visualizza un messaggio 
che indica di spegnere e riaccendere lo strumento. Non eseguire subito lo 
spegnimento e la riaccensione. Premere Clear (Cancella).

3 Scorrere fino a GW. Immettere il numero di gateway e premere Enter (Invio). 
Il sistema 6890N visualizza un messaggio che indica di spegnere e 
riaccendere lo strumento. Non eseguire subito lo spegnimento e la 
riaccensione. Premere Clear (Cancella).

4 Scorrere fino a SM e premere Mode/Type (Modo/Tipo). Scorrere fino alla 
subnet mask appropriata nell'elenco dei modi e premere Enter (Invio). Il 
sistema 6890N visualizza un messaggio che indica di spegnere e riaccendere 
lo strumento.

5 Spegnere e riaccendere lo strumento per applicare le impostazioni LAN alla 
scheda.

6 Premere Options (Opzioni). Scorrere fino a Communications (Comunicazioni) 
e premere Enter (Invio). Controllare che siano presenti le impostazioni 
corrette.

* Se non si conoscono i valori per l'indirizzo IP, il gateway o la subnet mask per il computer della 
ChemStation, Agilent consiglia di impostare l'indirizzo IP PC predefinito su 10.1.1.100, il GC o il 
modulo di controllo A/D su valori compresi tra 10.1.1.101 e 10.1.1.105, il gateway predefinito su 
10.1.1.100 e la subnet mask predefinita su 255.255.255.0.
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Configurazione dell'indirizzo IP per il sistema Agilent 6850 GC 

Questa procedura fa riferimento ai sistemi GC Serie 6850 
(con predisposizione LAN).

1 Spegnere il sistema GC.

2 Premere e tenere premuto LOAD (CARICA) e accendere il sistema GC. 
Continuare a tenere premuto LOAD fino a che non compaiono sul display 
cinque punti.

3 All'avvio del GC, viene visualizzato: 
 
DHCP MODE: 
DISABLED 
 
Se la modalità DHCP non è impostata su DISABLED (DISABILITATA), 
premere ▲ o ▼ per passare a DISABLED. Premere LOAD per passare alla voce 
successiva.

4 Sul display viene visualizzato: 
 
IP ADDRESS 
XXX.XXX.XXX.XXX 

5 Premere LOAD (CARICA) per modificare i valori dell'indirizzo IP 
(IP ADDRESS). Premere ▲ o ▼ per modificare i valori e quindi LOAD 
per passare da un valore al successivo.* 

6 Al completamento dell'indirizzo IP, viene visualizzato: 
 
DEFAULT GATEWAY 
XXX.XXX.XXX.XXX 

7 Modificare il gateway predefinito (DEFAULT GATEWAY) in modo analogo 
a IP ADDRESS.*

8 Allo stesso modo modificare il valore della SUBNET MASK.*

9 Spegnere e riaccendere il sistema GC affinché le nuove impostazioni 
vengano implementate.

* Se non si conoscono i valori per l'indirizzo IP, il gateway o la subnet mask per il computer della 
ChemStation, Agilent consiglia di impostare l'indirizzo IP PC predefinito su 10.1.1.100, il GC o il 
modulo di controllo A/D su valori compresi tra 10.1.1.101 e 10.1.1.105, il gateway predefinito su 
10.1.1.100 e la subnet mask predefinita su 255.255.255.0.
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Installazione del Servizio BootP Agilent

Le schede JetDirect J4100A e LAN G1369A utilizzate per collegare gli 
strumenti analitici a una LAN richiedono il protocollo di bootstrap. 
Agilent supporta solo il Servizio BootP Agilent, disponibile sul DVD della 
ChemStation.

Questa sezione descrive come installare il software del Servizio BootP Agilent. 
Il Servizio BootP Agilent assegnerà gli indirizzi a tutti i dispositivi che non 
sono in grado di assegnarsi il proprio indirizzo.

Scopo

Il Servizio BootP Agilent consente di amministrare centralmente gli indirizzi 
IP degli strumenti Agilent presenti su una rete LAN. Il servizio viene eseguito 
sul PC LAN dello strumento, che deve supportare il protocollo di rete TCP/IP 
e non può utilizzare un server DHCP.

Quando uno strumento viene acceso, una scheda Agilent Jet Direct presente 
sullo strumento trasmette una richiesta di indirizzo IP o nome host e fornisce 
il proprio indirizzo hardware come identificativo. La richiesta viene ripetuta 
per un massimo di 5 minuti. Il Servizio BootP Agilent risponde alla richiesta 
e passa un indirizzo IP definito in precedenza e un nome host associato 
all'indirizzo hardware dello strumento richiedente.

Quando lo strumento riceve l'indirizzo IP e il nome host, interrompe la 
trasmissione della richiesta e mantiene l'indirizzo IP per tutto il tempo in cui 
rimane acceso. Lo spegnimento dello strumento causa la perdita dell'indirizzo 
IP, quindi la necessità di riavviare il Servizio BootP Agilent. Poiché il Servizio 
BootP Agilent viene eseguito in background, lo strumento riceve il suo 
indirizzo IP all'accensione.

Indirizzi

Prima di installare e configurare il Servizio BootP Agilent, è necessario 
conoscere gli indirizzi IP del computer e degli strumenti, la subnet mask 
e il gateway (vedere il Capitolo 1).
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Installazione

Attenersi alla procedura descritta di seguito per installare il Servizio BootP 
Agilent.

1 Accedere al sistema come amministratore o come utente con privilegi 
di amministrazione.

2 Chiudere tutti i programmi Windows.

3 Inserire il DVD del software della ChemStation Agilent nell'apposita unità. 
Se il programma di installazione si avvia automaticamente, fare clic su 
Cancel (Annulla) per interromperlo.

4 Aprire Esplora risorse di Windows.

5 Fare doppio clic su BootPPackage.msi nella directory BootP del DVD del 
software della ChemStation Agilent.

6 Se necessario, fare clic sull'icona Agilent BootP Service... (Servizio BootP 
Agilent) nella barra delle applicazioni.

7 Viene visualizzata la finestra iniziale. Fare clic su Next > (Avanti).

8 Viene visualizzata la schermata del contratto di licenza. Leggere il contratto 
e fare clic su Yes (Sì).

9 Fare clic su Install (Installa).

NOTA Se si utilizza la comunicazione LAN o si passa da un GPIB a una connessione LAN, 
è necessario utilizzare il Servizio BootP Agilent con la ChemStation (Rev. B.04.02) per 
fornire gli indirizzi IP agli strumenti che non possono assegnarsi i propri indirizzi IP. Il server 
BootP CAG non è supportato. Prima di installare il programma del Servizio BootP Agilent, 
rimuovere il server BootP CAG dal computer.
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10 I file vengono caricati e al termine dell'installazione viene visualizzata 
la schermata BootP Settings (Impostazioni BootP).

• Questa finestra contiene le impostazioni predefinite non ancora configurate, 
che verranno specificate durante la procedura di configurazione.

• Usare l'utilità IPCONFIG per verificare le impostazioni TCP/IP: aprire 
una finestra del prompt dei comandi e digitare ipconfig/all.

11 Selezionare la casella di controllo Do you want to log BootP requests? 
(Registrare richieste BootP?).

La casella Do you want to log BootP requests? deve essere deselezionata al 
termine della configurazione degli strumenti, altrimenti il file di registro 
riempirà rapidamente lo spazio su disco.

12 Nella sezione Default Settings (Impostazioni predefinite) della schermata, 
immettere i dati della subnet mask e del gateway. Se non si conoscono i dati 
relativi alla subnet mask e al gateway, rivolgersi all'amministratore di rete.

• La subnet mask predefinita è 255.255.255.0.

• Il gateway predefinito è 10.1.1.101.

13 Fare clic su OK. Viene visualizzata la finestra Agilent BootP Service Setup 
(Impostazione Servizio BootP Agilent).

14 Fare clic su Finish (Fine) per uscire da tale schermata.

15 Rimuovere il DVD dall'unità.
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L'installazione è completata.

Il file README per il Servizio BootP Agilent è disponibile per la stampa. 
È possibile accedervi da C:\Programmi\Common Files\Agilent Shared\
BootP\bin\Readme.htm.

Assegnazione degli indirizzi IP agli strumenti mediante il Servizio BootP Agilent

Il Servizio BootP Agilent gestisce l'associazione tra un codice di 
identificazione univoco (indirizzo MAC) fornito dalla scheda LAN installata 
in un determinato strumento e l'indirizzo IP specifico assegnato allo stesso 
strumento. Di conseguenza, ogni volta che si aggiunge un nuovo strumento, lo 
si sostituisce (o si sostituisce la relativa scheda LAN) o si modifica l'indirizzo 
IP assegnato, è necessario definire o ridefinire tale associazione.

Configurazione degli strumenti mediante il Servizio BootP Agilent

1 Individuare l'indirizzo MAC del sistema GC con scheda JetDirect installata, 
tramite:

• Servizio BootP Agilent (vedere il passaggio 2)

• Scheda JetDirect (vedere il passaggio 3)

2 Utilizzo del Servizio BootP Agilent per determinare l'indirizzo MAC del GC:

a Spegnere il modulo GC e riaccenderlo.

b Al termine del test di autodiagnosi, aprire il file di registro utilizzando 
Blocco note. 

• La posizione predefinita del file di registro è Risorse del computer\
Disco locale\Programmi\Common Files\Agilent Shared\BootP\bin\
logfile.

• Non è possibile aggiornare il file di registro mentre è aperto.

• Assegnare un indirizzo solo ai dispositivi che non supportano 
l'assegnazione automatica. Per ulteriori informazioni consultare la 
documentazione relativa al funzionamento dello strumento.

Verrà visualizzata una finestra simile alla seguente:
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02/25/04 15:30:49 PM 
Status: BootP Request received at outermost layer 
Status: BootP Request received from hardware address: 0010835675AC  
Error:   Hardware address not found in BootPTAB: 0010835675AC 
Status: BootP Request finished processing at outermost layer 

c Trascrivere o memorizzare l'indirizzo MAC (ad esempio, 0010835675AC), 
nell'esempio denominato hardware address (indirizzo hardware).

d Chiudere il file di registro prima di accendere un altro strumento. 

e Passare al passaggio 4.

3 Utilizzo di una scheda JetDirect per determinare l'indirizzo MAC del GC:

a Spegnere lo strumento.

b Rimuovere la scheda JetDirect.

c Leggere l'indirizzo MAC riportato sull'etichetta.

L'indirizzo MAC è stampato su un'etichetta apposta nella scheda 
JetDirect sul lato opposto a quello dei componenti. È il numero sotto il 
codice a barre dopo i due punti (:) e in genere inizia con le lettere AD. 

d Installare nuovamente la scheda.

e Accendere il GC.

4 Aggiungere lo strumento GC alla rete.

a Fare clic su Start > Programmi > Agilent BootP Service e selezionare Edit 
BootP Settings (Modifica impostazioni BootP). Viene visualizzata la 
finestra BootP Settings (Impostazioni BootP).

b Deselezionare Do you want to log BootP requests? (Registrare richieste BootP?).

La casella Do you want to log BootP requests? deve essere deselezionata al 
termine della configurazione degli strumenti, altrimenti il file di registro 
riempirà rapidamente lo spazio su disco.

c Fare clic su Edit BootP Addresses... (Modifica indirizzi BootP).

d Fare clic su Add… (Aggiungi...). Viene visualizzata la finestra Add BootP 
Entry (Aggiungi elemento BootP).
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e Immettere i seguenti valori per il sistema GC:

• Indirizzo MAC

• Nome host

• Indirizzo IP

• Eventuali note

• Subnet mask

• Indirizzo gateway

f Fare clic su OK.

g Uscire da BootP Manager e spegnere e riaccendere il sistema GC.

Se si modifica l'indirizzo IP, è necessario spegnere e riaccendere lo 
strumento per rendere effettiva la modifica.

h Inviare un comando di ping all'indirizzo IP per verificare che funzioni.

5 Aggiungere uno strumento o un dispositivo aggiuntivo alla rete.

a Ripetere il passaggio 4 per ogni strumento o dispositivo della rete che 
richiede il Servizio BootP.

b Al termine, fare clic su Close (Chiudi).

c Fare clic su OK.



Preparazione all'installazione 1

Installazione della ChemStation 23

Configurazione del Servizio BootP Agilent

Il Servizio BootP Agilent si avvia automaticamente al riavvio del PC. 
Per modificare le impostazioni del Servizio BootP Agilent è necessario 
arrestare il servizio, apportare le modifiche, quindi riavviarlo. Attenersi alla 
procedura descritta di seguito per configurare il Servizio BootP Agilent.

Arresto del Servizio BootP Agilent

1 Dal Pannello di controllo di Windows, selezionare Strumenti di 
amministrazione > Servizi. Viene visualizzata la finestra di dialogo Servizi.

2 Fare clic con il pulsante destro del mouse su Agilent BootP Service.

3 Selezionare Arresta.

4 Chiudere le finestre Servizi e Strumenti di amministrazione.

Modifica delle impostazioni

1 Selezionare Start > Programmi > Agilent BootP Service, quindi selezionare Edit 
BootP Settings (Modifica impostazioni BootP). Viene visualizzata la finestra 
BootP Settings (Impostazioni BootP).
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2 La prima volta che questa finestra viene aperta, sono visualizzate 
le impostazioni predefinite derivanti dall'installazione.

Configurazione del TabFile

Per creare un nuovo modello per il TabFile, selezionare Create Tab File 
(Crea TabFile).

Il TabFile predefinito creato al momento dell'installazione si trova in  
C:\Programmi\Common Files\Agilent Shared\BootP\bin\TabFile. Questo 
file contiene le informazioni di configurazione immesse in questa finestra.

Configurazione del file di registro

Selezionare la casella Do you want to log BootP requests? (Registrare richieste 
BootP?) per registrare tutte le richieste effettuate al sistema GC e acquisire 
l'indirizzo MAC. Deselezionare la casella Do you want to log BootP requests? dopo 
aver configurato gli strumenti per evitare che il file di registro utilizzi uno 
spazio su disco eccessivo.

Il file di registro predefinito creato al momento dell'installazione si trova in 
C:\Programmi\Common Files\Agilent Shared\BootP\bin\logfile. Questo file 
contiene una voce per ogni volta che un dispositivo richiede informazioni sulla 
configurazione da BootP.

Riavvio del Servizio BootP Agilent

1 Dal Pannello di controllo di Windows, selezionare Strumenti di 
amministrazione > Servizi. Viene visualizzata la finestra di dialogo Servizi.

2 Fare clic con il pulsante destro del mouse su Agilent BootP Service, 
quindi selezionare Avvia.

3 Chiudere le finestre Servizi e Strumenti di amministrazione.

La configurazione è completata.
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Installazione e configurazione della scheda di interfaccia GPIB Agilent

Se non si utilizza la comunicazione GPIB, è possibile ignorare questa sezione.

Installazione e configurazione della scheda di interfaccia GPIB 

Per installare la scheda di interfaccia GPIB, fare riferimento al manuale 
del computer o seguire le brevi istruzioni riportate di seguito.

1 Spegnere il computer e staccare la spina, quindi rimuovere le coperture.

2 Selezionare uno slot vuoto in cui installare la scheda GPIB. Se la scheda 
viene collocata nell'ultimo slot del PC si potrebbero verificare interferenze 
con il cavo GPIB.

3 Allentare la vite di montaggio e rimuovere la piastra posteriore dello slot 
libero prescelto.

4 Tenere la scheda per i bordi e inserirla nello slot. Accertarsi che il 
connettore sul bordo della scheda sia collocato in posizione corretta. 
Fissare la scheda con l'apposita vite di montaggio.

5 Riposizionare le coperture del computer. Inserire la spina e riavviare il 
computer.

6 Dopo aver installato la scheda GPIB sul computer, è necessario installare il 
driver corrispondente e il software di configurazione disponibili sul DVD 
della ChemStation Agilent nella directory di Agilent I/O Library Suite. Fare 
riferimento alla guida per l'installazione di Agilent I/O Library Suite 
disponibile sul DVD della ChemStation DVD nella cartella Support\
Manuals\Installation.

ATTENZIONE Spegnere il computer e staccare la spina di tutti i dispositivi elettrici prima di 
rimuovere qualsiasi copertura. Prima di installare la scheda GPIB, indossare una 
fascetta antistatica.
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Cavi GPIB

Quando si collegano i dispositivi GPIB tra loro, tenere presenti le regole 
seguenti:

• Se possibile, staccare la spina e spegnere il computer e tutti i dispositivi 
ad esso collegati prima di installare i cavi GPIB.

• Prima di collegare qualsiasi strumento analitico a un cavo GPIB, consultare 
la documentazione fornita con ciascun dispositivo e determinare il 
corrispondente indirizzo GPIB. Non è possibile collegare due dispositivi 
alla ChemStation Agilent con lo stesso indirizzo. Scrivere tutti gli indirizzi 
GPIB. Queste informazioni saranno utili in seguito.

• Quando possibile, utilizzare cavi GPIB di lunghezza non superiore a 
due metri. 
 
Cavo (0,5 m) (Codice 10833D) 
Cavo (1 m) (Codice 10833A) 
Cavo (2 m) (Codice 10833B) 
Cavo (4 m) (Codice 10833C)

• Collegare un'estremità del cavo GPIB al connettore GPIB del computer. 
Accertarsi di stringere bene tutti i connettori GPIB. Connessioni deboli 
possono causare errori difficili da diagnosticare.

• Collegare i dispositivi GPIB a catena (in serie). Una catena si ottiene 
quando un dispositivo GPIB viene collegato al dispositivo successivo, 
quest'ultimo, a sua volta, viene collegato al seguente e così via. Evitare 
configurazioni a stella (in parallelo, collegamento di tutti i dispositivi con 
un punto centrale).

AVVERTENZA La ChemStation Agilent non supporta prolunghe GPIB.
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Questo capitolo descrive come:

• Impostare il PC per installare il nuovo software della ChemStation Agilent

• Installare la ChemStation Agilent per la prima volta

• Immettere le licenze degli strumenti durante l'installazione

• Aggiungere la licenza di uno strumento a una ChemStation Agilent esistente

• Aggiornare la ChemStation Agilent
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Prima di iniziare

Prima di installare il software della ChemStation Agilent, configurare il PC 
come indicato di seguito:

1 Verificare che il PC risponda ai requisiti minimi pertinenti.

2 Impostare le comunicazioni per lo strumento come descritto nel Capitolo 1.*

3 Accedere al PC con privilegi di amministratore Windows.

4 Dal Pannello di controllo, aprire Opzioni internazionali e della lingua. 
Nella scheda Opzioni internazionali, impostare la lingua su English (US). 
Se si sceglie un'altra lingua, è necessario anche configurare le impostazioni 
descritte di seguito.

• Separatore decimale = . (punto)

• Simbolo di raggruppamento cifre = , (virgola) 

• Separatore di elenco = , (virgola)

Nella scheda Avanzate, impostare Lingua per programmi non Unicode su 
English (US).

5 Disattivare le impostazioni di gestione avanzata dell'energia elettrica sul 
computer, quali la funzione di standby e di sospensione del sistema.

Per ulteriori informazioni sull'ottimizzazione del funzionamento in Windows 
XP o Windows Vista, attenersi alle istruzioni riportate nel documento 
Configure and Maintain Your ChemStation Computer (Configurazione 
e gestione del computer della ChemStation), disponibile in formato PDF nel 
DVD della ChemStation Agilent. Vengono descritte le impostazioni di sistema 
richieste per garantire le migliori prestazioni della ChemStation.

* Non applicabile al software di analisi dei dati della ChemStation Agilent.

NOTA Se si esegue l'aggiornamento del software della ChemStation, è possibile che siano 
necessarie alcune modifiche al sistema operativo e all'hardware, prima dell'installazione 
del nuovo software. Per istruzioni dettagliate sulla preparazione del PC per l'aggiornamento, 
leggere il documento Upgrade Preparation Guide for Agilent ChemStation B.04.02 (Guida 
alla preparazione dell'aggiornamento per la ChemStation Agilent). La documentazione è 
disponibile in formato cartaceo e in formato PDF nella directory dei manuali presente nel 
DVD della ChemStation Agilent.
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Procedure di installazione

Fare riferimento alle istruzioni seguenti, in base al tipo di installazione da 
eseguire:

• "Installazione iniziale" a pagina 29

• "Aggiornamento del software (a B.04.02)" a pagina 34

Installazione iniziale

Di seguito viene descritto come eseguire l'installazione del software della 
ChemStation Agilent per la prima volta.

Consultare la sezione pagina 35 per istruzioni sull'aggiunta di uno strumento 
al software della ChemStation Agilent. Consultare la sezione pagina 34 
per istruzioni sull'aggiunta o la reinstallazione del software della 
ChemStation Agilent.

Per un'installazione iniziale del software della ChemStation Agilent:

1 Accertarsi che tutti i passaggi descritti in "Prima di iniziare" a pagina 28 
siano stati completati.

2 Accertarsi che non vi siano programmi aperti nel sistema.

3 Se si sta eseguendo l'aggiornamento della ChemStation, accertarsi di avere 
eseguito una copia di backup dei metodi, delle sequenze, dei file di dati e 
dei database delle colonne (6890COL.MDB, CATALOG.MDB, 6850COL.MDB 
e 6850CAT.MDB) in un'altra posizione prima dell'aggiornamento.

4 Inserire il DVD del software della ChemStation Agilent nell'apposita unità. 

5 Selezionare Esegui dal menu Start.

6 Sulla riga di comando digitare unità:\Install\Setup.exe (ad esempio,  
E:\Install\Setup.exe), quindi fare clic su OK. Viene avviata la procedura 
guidata di installazione.

7 Accettare le richieste visualizzate dalle schermate dell'Installazione guidata 
InstallShield durante la prima parte dell'installazione.

NOTA I database delle colonne relativi alla ChemStation per GC si trovano nella cartella  
C:\Chem32\drivers.
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• Si consiglia di utilizzare la directory predefinita C:\Chem32 quando 
viene richiesto di specificare la directory di installazione della 
ChemStation Agilent.

• Se Microsoft .NET Framework 2.0 non è installato sul computer, verrà 
richiesto di installarlo ora. Passare alla directory dotNET Framework 
sul DVD della ChemStation ed eseguire dotnetFx.exe per installarlo ora, 
quindi ripetere i passaggi 5, 6 e 7.

• Se Microsoft .NET Framework 3.5 SP1 non è installato sul computer, 
verrà richiesto di installarlo ora. L'installazione di .Net 3.5 SP1 potrebbe 
richiedere un riavvio.

• Verrà richiesto di installare il software della stampante PDF. Questa 
stampante è richiesta e viene utilizzata per stampare i report di output 
in formato PDF.

8 Configurare il numero e il tipo di strumenti con l'Installazione guidata. 
Per aggiungere uno strumento, fare clic su uno dei pulsanti sul lato sinistro 
dello schermo.
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• È possibile aggiungere fino a quattro strumenti facendo clic sui pulsanti 
appropriati (ciascuno strumento richiede una licenza). 

• Se si seleziona uno strumento di analisi dati una volta selezionato uno 
strumento GC o LC, verranno annullate tutte le selezioni precedenti.
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9 Immettere le licenze necessarie una volta aggiunti i tipi di strumenti.

Immettere il numero di licenza appropriato nel campo apposito, quindi fare 
clic su Add (Aggiungi). Il campo di testo viene cancellato e il codice viene 
aggiunto accanto al nome del modulo visualizzato. È richiesta una sola 
licenza completa per tipo di strumento.

Se si immettono licenze per diversi tipi di strumenti (ad esempio, GC, A/D 
o LC), tenere presente che il tipo di licenza immesso in questo punto 
per ciascuno strumento ne determina la modalità di configurazione. 
Ad esempio, se si immette una licenza GC per lo Strumento 1, tale 
strumento verrà configurato come GC.

10 Fare clic su Finish (Fine) per completare l'Installazione guidata. 
Viene visualizzato automaticamente Configuration Editor.

NOTA Se si immette una licenza non valida o di tipo errato, il campo di inserimento del testo 
cambia da nero in rosso e viene visualizzato un messaggio ad indicare che la licenza 
non è stata accettata.

NOTA Non è necessario riavviare il computer.
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11 Completare le finestre di Configuration Editor. Per le procedure di configurazione 
degli strumenti, vedere il Capitolo 3, "Configurazione degli strumenti". 

12 Una volta configurati gli strumenti, selezionare File > Save (File > Salva).

13 Chiudere Configuration Editor.

14 Dopo aver installato il software e configurati gli strumenti, conservare il 
DVD del prodotto ChemStation e qualsiasi numero di licenza in un luogo 
sicuro. Disco e numeri di licenza saranno richiesti se occorrerà installare 
nuovamente il software o aggiungere un nuovo modulo strumento o licenza.
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Aggiornamento del software (a B.04.02)

Se si sta eseguendo l'aggiornamento dalla ChemStation B.01.01 o superiore, 
vedere la Upgrade Quick Reference Guide (Guida di riferimento rapido 
all'aggiornamento) disponibile nella directory dei manuali del DVD della 
ChemStation Agilent. Salvare i metodi, le sequenze, i file di dati e i database delle 
colonne per ciascuno strumento prima di eseguire una nuova installazione.

I database delle colonne per la ChemStation GC si trovano nella sottocartella \
driver; ad esempio, C:\Chem32\drivers.

Attivazione dell'interfaccia basata su XML

Se si utilizza un LIMS o altri sistemi di raccolta dati esterni, la ChemStation 
Agilent fornisce un'interfaccia XML per leggere elenchi di immissioni di 
campioni, analizzarli e quindi inviare di nuovo i risultati al sistema LIMS. 
Per abilitare questa funzionalità, è necessario modificare il file 
CHEMSTATION.INI. Per informazioni dettagliate, fare riferimento al manuale 
Agilent ChemStation Plus XML Connectivity Guide (Guida alla connettività 
XML Plus della ChemStation Agilent) nella directory \Support\Manuals del 
DVD della ChemStation Agilent. 

NOTA Prima di eseguire l'aggiornamento, è necessario rimuovere tutte le versioni Service Release 
e i prodotti aggiuntivi della ChemStation. Vedere la Upgrade Quick Reference Guide (Guida 
di riferimento rapido all'aggiornamento).
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Aggiunta di uno strumento a un'installazione esistente

Per aggiungere uno strumento a un'installazione esistente:

1 Selezionare Programmi > Agilent ChemStation > Add Instrument (Aggiungi 
strumento). Viene avviata l'Installazione guidata della ChemStation.

• Non è possibile modificare o eliminare gli strumenti configurati.

• Una singola installazione della ChemStation supporta un massimo di 
4 strumenti.

2 Attenersi alle istruzioni dal passaggio 8 al passaggio 10 a pagina 30.

3 Eseguire un report IQT per verificare la ChemStation dopo l'aggiunta degli 
strumenti. Vedere "Esecuzione della procedura di validazione IQT" 
a pagina 55.
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Installazione dei Control Charts Reports (Report grafici di controllo)

La procedura seguente consente di aggiungere l'opzione Control Charts al 
menu dei report.

Per utilizzare questa funzione, sul PC deve essere installato Microsoft 
Excel 2000, XP o 2003.

Dopo aver installato la ChemStation Agilent e aver riavviato il PC, 
è possibile installare la funzione Control Charts.

1 Avviare la ChemStation Agilent.

2 Individuare la riga di comando della ChemStation Agilent. La riga di 
comando è un campo di immissione di testo nella parte inferiore della 
finestra del programma della ChemStation Agilent.

3 Sulla riga di comando, digitare MACRO STARTCHT.MAC,GO e premere Enter 
(Invio).

4 Viene visualizzata una finestra di dialogo con informazioni 
sull'installazione.

5 Per informazioni sull'utilizzo dei grafici di controllo con la ChemStation 
Agilent, fare clic su Help (Guida) nella finestra di dialogo.

6 Fare clic su OK per installare la funzione Control Chart per la ChemStation 
Agilent. 
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Questo capitolo descrive come utilizzare Configuration Editor per configurare 
gli strumenti con la ChemStation Agilent per GC, la ChemStation per analisi 
dati e la ChemStation per A/D 35900E. 
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Informazioni su Configuration Editor della ChemStation Agilent

Il programma Configuration Editor della ChemStation Agilent consente di 
configurare facilmente il software della ChemStation Agilent, vale a dire di 
effettuare le seguenti operazioni:

• Rivelare l'interfaccia GPIB sul PC

• Selezionare la comunicazione LAN o GPIB

• Configurare l'hardware analitico collegato al PC

• Configurare il percorso usato per la memorizzazione di metodi, 
dati e sequenze

• Configurare il display a colori della ChemStation Agilent

È necessario utilizzare Configuration Editor:

• Come ultima fase del processo di installazione iniziale per il software 
della ChemStation Agilent

• Ogni volta che viene collegato, modificato o disconnesso un dispositivo 
GPIB dal bus GPIB o dal PC

• Ogni volta che si modifica l'indirizzo IP di un dispositivo LAN e quando 
si aggiunge o rimuove un dispositivo LAN dal software della ChemStation

Dopo avere installato il software della ChemStation Agilent, viene richiesto 
di configurare il sistema analitico completo.
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Configurazione della ChemStation Agilent per i sistemi GC  
(7890A, 6890, 6850 e 5890/4890)

Dopo aver installato il software della ChemStation, seguire la procedura 
illustrata di seguito affinché la ChemStation Agilent possa identificare e 
controllare l'hardware.

1 Se non ancora avviato, avviare Configuration Editor: Start > Programmi > 
ChemStation Agilent > Configuration Editor. Nella finestra iniziale di 
Configuration Editor, evidenziare la barra del titolo dello strumento 
installato con una licenza GC e selezionare Configure > Instruments... 
(Configura > Strumenti...). Viene visualizzata la finestra Select Instrument 
(Seleziona strumento). 

2 Selezionare il modello di strumento dall'elenco dei tipi di strumento 
(ad esempio, 7890A GC). Tenere presenti le seguenti eccezioni:

• Per controllare un sistema GC 6890 o 6850 Agilent che include un 
ALS 7683, 7673C o nessun ALS, selezionare 6890 GC (Classic) o 6850 GC 
(Classic).

• Per controllare un sistema GC 6890 o 6850 Agilent che include un 
ALS 7693A, selezionare 6890 GC o 6850 GC. 

Barra del titolo

Configure > Instruments... 
(Configura > Strumenti)
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• Per controllare un sistema GC 4890D, selezionare 5890 GC. 

3 Accettare il nome dello strumento o digitarne uno nuovo nel campo 
Instrument Name (Nome strumento). Il nome digitato in questo campo 
verrà visualizzato nella barra del titolo quando si utilizza la ChemStation 
Agilent.

4 Selezionare Initial Screen Window Size (Dimensione iniziale finestra) per 
specificare come verrà aperto il programma. 

5 Fare clic su OK per continuare. 

6 Completare le informazioni nella finestra Device Configuration 
(Configurazione dispositivo).  

Specificare il tipo di connessione fra il PC e lo strumento:

• LAN (IP) + Indirizzo IP

• LAN (Host) + Nome host

• GPIB + Indirizzo GPIB 

Passaggio 
2

Passaggio 
3

Passaggio 
4
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Alcuni tipi di GC includono un campo Port Address (Indirizzo porta). A meno 
che non venga indicato diversamente, accettare la porta predefinita 9100.

7 Configurare i dispositivi opzionali.

• Per configurare il campionatore 7673 in un sistema GC 5890/4890 - 
Se si dispone di un campionatore 7673 collegato a un sistema GC 
5890/4890, evidenziare "7673 Sampler" nella casella Options (Opzioni), 
specificare l'indirizzo GPIB nell'apposito campo, quindi fare clic su Add 
(Aggiungi).
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• Per configurare un'interfaccia a due canali 35900E come 1 o 2 rivelatori 
GC - Se si dispone di un A/D 35900E collegato a un sistema GC 6890, 6850 
o 5890 per controllare segnali supplementari, evidenziare "35900E" nella 
casella Options (Opzioni), fare clic su Add (Aggiungi), completare le voci 
relative al tipo di interfaccia e al canale e fare clic su OK. 

8 Fare clic su OK nella finestra Device Configuration (Configurazione 
dispositivo) per tornare alla finestra principale di Configuration Editor, 
illustrata nel passaggio 1.

9 Fare clic su File > Save (File > Salva).

10 Fare clic su File > Exit (File > Esci) per tornare a Windows.
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Configurazione della ChemStation Agilent per i sistemi di analisi dei dati

Dopo aver installato il software della ChemStation, seguire la procedura 
illustrata di seguito affinché la ChemStation Agilent possa identificare 
e controllare il sistema di analisi dei dati.

1 Se non ancora avviato, avviare Configuration Editor: Start > Programmi > 
ChemStation Agilent > Configuration Editor. Nella finestra iniziale di 
Configuration Editor, evidenziare la barra del titolo dello strumento 
pertinente e selezionare Configure > Instruments... (Configura > Strumenti...). 
Viene visualizzata la finestra Select Instrument (Seleziona strumento). 

NOTA Per le configurazioni "Data Analysis Only" (Solo analisi dati), non modificare alcuna 
impostazione predefinita in Configuration Editor, a parte, eventualmente, Instrument 
Name (Nome strumento) (passaggio 3). 
Instrument 1 deve essere impostato come Gas Chromatograph (GC or A/D Data Analysis 
Only) e Instrument 2 come Liquid Chromatograph (LC Data Analysis Only).

Barra del titolo

Configure > Instruments... 
(Configura > Strumenti)
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2 Dall'elenco "Instrument Type" (Tipo strumento) selezionare GC or A/D Data 
Analysis only (Solo analisi dati GC o A/D).  

3 Accettare il nome dello strumento o digitarne uno nuovo nel campo 
Instrument Name (Nome strumento). Il nome digitato in questo campo 
verrà visualizzato nella barra del titolo quando si utilizza il software della 
ChemStation Agilent. 

4 Selezionare Initial Screen Window Size (Dimensione iniziale finestra) 
per specificare come verrà aperto il programma. 

5 Fare clic su OK per continuare. 

6 Fare clic su File > Save (File > Salva).

7 Fare clic su File > Exit (File > Esci) per tornare a Windows.

Passaggio 
2

Passaggio 
3

Passaggio 
4
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Configurazione della ChemStation Agilent per i sistemi di interfaccia A/D 
35900E

Questa sezione descrive come configurare l'interfaccia Analogico/Digitale 
35900E. L'interfaccia A/D 35900E richiede il Servizio BootP Agilent 
("Installazione del Servizio BootP Agilent" a pagina 17).

1 Se non ancora avviato, avviare Configuration Editor: Start > Programmi > 
ChemStation Agilent > Configuration Editor. Nella finestra iniziale di 
Configuration Editor, evidenziare la barra del titolo dello strumento 
installato con una licenza A/D 35900E e selezionare Configure > Instruments... 
(Configura > Strumenti...). Viene visualizzata la finestra Select Instrument 
(Seleziona strumento). 

2 Dall'elenco " Instrument Type" (Tipo strumento), selezionare lo strumento 
35900E ADC che si desidera controllare. 

Barra del titolo

Configure > Instruments... 
(Configura > Strumenti)

Passaggio 
2

Passaggio 
3

Passaggio 
4
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3 Accettare il nome dello strumento o digitarne uno nuovo nel campo 
Instrument Name (Nome strumento). Il nome digitato in questo campo 
verrà visualizzato nella barra del titolo quando si utilizza la ChemStation 
Agilent.

4 Selezionare Initial Screen Window Size (Dimensione iniziale finestra) per 
specificare come verrà aperto il programma. 

5 Fare clic su OK per continuare.

6 Selezionare Interface Type (Tipo interfaccia), quindi immettere l'indirizzo 
IP o il nome host.

7 Per la raccolta dei segnali con la ChemStation Agilent, selezionare i canali 
appropriati da utilizzare. L'esempio precedente mostra una configurazione 
a un canale (A). Per ulteriori informazioni, fare riferimento al manuale 
utente di 35900E. 

8 Se la ChemStation Agilent controlla un campionatore, fare clic su Change... 
(Modifica) nel gruppo Sampler (Campionatore). Nella finestra di dialogo 
Sampler (Campionatore), selezionare Other (Altro) come Sampler Type 
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(Tipo campionatore) ed effettuare le scelte appropriate per le voci 
rimanenti. Fare clic su OK.

9 Definire le opzioni External Start/Stop e Ready Status (Avvio/Arresto 
esterno e Stato pronto). Per accedere alla finestra di dialogo, fare clic 
su Change (Modifica) nella casella di gruppo External Start/Stop 
(Avvio/Arresto esterno). Nella finestra di dialogo sono riportate le opzioni 
per avvio/arresto esterno e per lo stato di pronto per il 35900.

a Selezionare un'opzione appropriata tra le tre disponibili per 
avvio/arresto.

b Selezionare l'opzione appropriata per lo stato di pronto.

• Selezionare la casella ChemStation displays status of ready signal 
(ChemStation visualizza lo stato di segnale pronto) affinché la 
ChemStation Agilent visualizzi a schermo un segnale di stato 
dell'analisi quando lo strumento è pronto.
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• Selezionare la casella ChemStation waits for ready signal (ChemStation 
attende per segnale di pronto) affinché la ChemStation Agilent 
attenda un segnale di pronto dallo strumento, prima di procedere 
a qualsiasi elaborazione automatica. 

c Per tornare alla finestra di dialogo Device Configuration (Configurazione 
dispositivo), fare clic su OK.

10 Configurare i pulsanti del 35900. La finestra di dialogo 35900 Buttons 
(Pulsanti del 35900) offre opzioni per stabilire se i pulsanti del pannello 
anteriore del 35900 possono avviare o interrompere un'analisi manuale. 
Per accedere alla finestra di dialogo 35900 Buttons (Pulsanti del 35900), 
fare clic su Change (Modifica).

a Selezionare le opzioni appropriate di avvio/arresto per il 35900.

b Per tornare alla finestra di dialogo Device Configuration (Configurazione 
dispositivo), fare clic su OK.

11 Controllare gli eventi programmati. Per definire gli eventi programmati per 
il 35900E nella casella Define Events (Definisci eventi), fare clic su Change 
(Modifica).

• Se si utilizza il 35900E in modalità Remote Bus (Bus remoto) 
(impostazione predefinita), saltare questa sezione. Non è applicabile 
alla propria configurazione.

• Se si utilizza il 35900E in modalità I/O digitale programmabile, sarà 
possibile programmare fino a 16 eventi nella ChemStation Agilent. Come 
prima operazione, è necessario immettere l'espressione da utilizzare per 
definire ogni evento, come descritto di seguito.
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• Ogni espressione definisce lo stato "attivato" (ad esempio, aperto) 
e lo stato disattivato (ad esempio, chiuso) di ciascuno strumento da 
controllare con il 35900E. In seguito sarà possibile programmare questi 
eventi utilizzando le espressioni immesse nella finestra di dialogo 
Defined Events (Eventi definiti) della ChemStation Agilent.

La Figura 1 mostra i pin da 7 a 9 come definiti dall'utente e quelli da 2 
a 6 come impostazioni predefinite.

Figura 1  Esempio di finestra Define Events (Definisci eventi) 

AVVERTENZA La correlazione tra l'espressione assegnata e il numero/stato del pin associato viene 
salvata con il file di definizione dello strumento. Il metodo memorizza e utilizza solo 
l'espressione stessa, ad esempio, Close Valve 1 (Chiudi valvola 1). Come risultato, 
se si copia un metodo da una copia della ChemStation Agilent a un'altra, e la seconda 
ha un'espressione di evento corrispondente ma strumenti diversi, i risultati possono 
essere imprevedibili. Di conseguenza è bene considerare l'associazione che si 
stabilisce tra uno strumento e un'espressione di evento come esclusiva per la specifica 
configurazione hardware in uso.
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a Immettere l'espressione che si desidera utilizzare per definire lo stato 
di disattivato (high) e di attivato (low) del primo strumento. È possibile 
utilizzare qualsiasi combinazione di caratteri e di numeri fino a un 
massimo di 20. 
 
Ad esempio, se si desidera controllare una valvola normalmente chiusa 
(una valvola che si apre solo quando viene applicata una tensione), 
si potrebbe assegnare un'espressione simile a quella illustrata 
nella Figura 1 a pagina 49. Questa espressione indica che la valvola 
è normalmente chiusa (lo stato "high" è chiuso) e quando viene applicata 
una tensione, entra in stato aperto (lo stato "low" è aperto). 
 
Se si preferisce, è anche possibile assegnare un'espressione più esplicita, 
quale ad esempio Close Nitrogen Valve (Chiudi valvola azoto) e Open 
Nitrogen Valve (Apri valvola azoto).

b Ripetere il processo descritto nel passaggio (a) per ogni ulteriore 
strumento che si desidera controllare.

c Per tornare alla finestra di dialogo Device Configuration (Configurazione 
dispositivo), fare clic su OK.

12 Controllare che le informazioni visualizzate nella finestra di dialogo Device 
Configuration siano corrette. Per modificare una di queste selezioni, fare 
clic su Change (Cambia) nella casella di gruppo appropriata.

13 Uscire dalla finestra di dialogo Device Configuration. Per tornare alla 
finestra principale Configuration Editor, fare clic su OK.

14 Salvare la configurazione del nuovo strumento. Selezionare File > Save 
(File > Salva). 

15 Se si desidera configurare più di uno strumento, selezionare un altro 
strumento e continuare. Se questo è l'unico strumento, selezionare 
File > Exit (File > Esci).
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Modifica dei percorsi dei file del metodo, della sequenza e dei dati

Il Configuration Editor consente di impostare percorsi alternativi per lo 
strumento, le sequenze, i metodi, i file dei dati e le macro degli strumenti. 
In questo modo è possibile archiviare i file di dati in un'unità separata.

Completare i passaggi seguenti per configurare i diversi percorsi per uno 
strumento.

1 Prima di modificare le impostazioni di percorso con Configuration Editor, 
è necessario creare le apposite directory.

2 Evidenziare la barra del titolo dello strumento da modificare.

3 Scegliere Paths (Percorsi) dal menu Configuration (Configurazione). Nella 
finestra di dialogo seguente, selezionare uno dei tipi di file da modificare 
per questo strumento: file di sequenza, file di dati, metodi, percorso macro 
o percorso strumento.

4 Modificare il percorso nel campo New Path (Nuovo percorso), quindi fare 
clic su Enter (Invio).

• Tutti i nomi di percorso devono terminare con una barra rovesciata (\).

• Ripetere queste operazioni per ogni percorso desiderato.

5 Scegliere OK per aggiornare le informazioni riguardanti i percorsi e per 
tornare a Configuration Editor.

La Tavola 4 elenca i percorsi di file predefiniti.

Tavola 4 Percorsi di file di dati predefiniti

Impostazione Percorso di file predefinito

File di sequenza C:\CHEM32\1\SEQUENCE\

File di dati C:\CHEM32\1\DATA\

Metodi C:\CHEM32\1\METHODS\

Percorso macro C:\CHEM32\CORE

Percorso strumento C:\CHEM32\1\
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Questo capitolo descrive come utilizzare il programma del report di 
qualificazione dell'installazione (IQT) della ChemStation Agilent per verificare 
la corretta installazione e le prestazioni operative della ChemStation Agilent 
nel PC. Viene inoltre descritto come iniziare a utilizzare la ChemStation 
Agilent, una volta validata l'installazione.
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Applicazione del report di qualificazione dell'installazione

Dopo aver installato sul computer il software del sistema ChemStation Agilent 
e aver configurato il sistema analitico, è possibile eseguire una procedura 
di validazione interna per verificare la correttezza e la completezza 
dell'installazione e la completa operatività del sistema analitico. Il programma 
IQT verifica i codici di versione dei file di sistema eseguibili della ChemStation 
Agilent (*.EXE, *.DLL) e i file di riferimento.

Il programma si serve di file di riferimento sull'installazione forniti dalla 
fabbrica per verificare l'esistenza, la correttezza e l'integrità dei file di sistema 
della ChemStation Agilent (programmi eseguibili, file di registro binari, di 
macro, di inizializzazione e della guida nonché modelli di rapporti 
personalizzati). 

L'integrità dei file viene verificata confrontando la somma di controllo di 
ridondanza incrociato (CRC) del file installato con quella del file originale 
registrato sul master di installazione Agilent Technologies. I particolari 
relativi ai file del master di installazione vengono riportati nei file di 
riferimento. File modificati o danneggiati generano somme di controllo 
differenti e vengono quindi individuati dal programma IQT.

Inoltre, l'integrità degli stessi file di riferimento viene controllata con l'aiuto 
delle somme di controllo. Se il programma di verifica dell'installazione viene 
fornito con file di riferimento che sono stati modificati successivamente alla 
loro creazione, ciò viene evidenziato nel rapporto sotto l'intestazione invalid 
reference files (file di riferimento non validi).

Come per qualsiasi importante aggiornamento del software della 
ChemStation, Agilent consiglia di eseguire una procedura di qualificazione 
dell'installazione (IQT) e di qualifica operativa/verifica delle prestazioni 
(OQ/PV) in seguito all'installazione della versione B.04.02 per verificarne 
la correttezza e la completezza.
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Esecuzione della procedura di validazione IQT

Il programma IQT della ChemStation Agilent viene installato 
automaticamente con i file di riferimento IQT appropriati.

Per eseguire la validazione:

1 Prima di eseguire il programma IQT, accertarsi che tutto il software della 
ChemStation Agilent sia chiuso.

2 Fare clic su Start > Programmi > ChemStation Agilent > IQT Report.

Il calcolo della somma di controllo per tutti i file di sistema della 
ChemStation Agilent può durare alcuni minuti. 

3 Lo strumento Agilent ChemStation IQ crea un html dei risultati della 
qualificazione (iqtreport.htm) nella directory principale della ChemStation 
(di solito c:\chem32). Il report viene visualizzato automaticamente a 
schermo dal browser Internet del sistema. Se l'installazione è completa e 
conforme, la procedura di qualificazione dell'installazione termina senza 
visualizzare messaggi di errore e senza segnalare alcun file come modificato 
o mancante. È quindi possibile stampare il rapporto dal browser.

Report di qualificazione dell'installazione

L'applicazione IQT riporta le categorie di file elencate nella Tavola 5:

Tavola 5 Categorie di file riportate dall'applicazione IQT 

Categoria di file Spiegazione Azione richiesta

Identical files 
(File identici)

I file richiesti sono presenti e hanno 
superato il controllo della versione e 
dell'integrità.

Non è richiesta alcuna azione.

Missing files 
(File mancanti)

I file necessari per eseguire la 
ChemStation Agilent non sono presenti.

Riparare o installare nuovamente la 
ChemStation Agilent.
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La Figura 2 e la Figura 3 mostrano un esempio di risultati dell'applicazione 
IQT. Nella Figura 2, l'installazione ha superato la validazione ed è accettabile. 
Nella Figura 3, l'installazione non ha superato la validazione a causa di un file 
mancante e di un file modificato.

Modified files 
(File modificati)

File che risultano modificati 
o danneggiati.*

Riparare o installare nuovamente il 
software della ChemStation Agilent, 
a meno che i file della ChemStation 
Agilent non siano stati personalizzati 
o aggiornati intenzionalmente. 

Invalid reference 
file (File di 
riferimento 
non valido)

Il file di riferimento originale risulta 
danneggiato oppure è stato modificato 
dopo la sua creazione.

Reinstallare il file di riferimento 
originale.

* Se è stata aggiornata la Agilent ChemStation senza rimuovere tutti i componenti aggiuntivi, 
l'applicazione IQT visualizzerà un errore. Rimuovere i componenti aggiuntivi come descritto nella 
Upgrade Quick Reference Guide (Guida di riferimento rapido all'aggiornamento) disponibile nella 
directory dei manuali del DVD della ChemStation Agilent. Quindi riparare o installare nuovamente 
la ChemStation.

Figura 2 Esempio di report IQT senza errori

Tavola 5 Categorie di file riportate dall'applicazione IQT (continua)

Categoria di file Spiegazione Azione richiesta
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Figura 3 Esempio di report IQT con errori
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Qualificazione del funzionamento/Verifica delle prestazioni 
(OQ/PV, Operation Qualification / Performance Verification)

Il servizio OQ/PV di Agilent fornisce un'evidenza documentata delle 
prestazioni del nuovo software della ChemStation in base ai parametri 
di prestazione accettati, verificando il funzionamento dell'algoritmo 
dell'integratore come parte dei test di verifica della cromatografia. Inoltre, 
vengono coperte altre aree importanti come la comunicazione e il controllo 
degli strumenti nonché la sicurezza dei dati e il controllo dell'accesso.

Per verificare che l'esecuzione del software della ChemStation corrisponda 
ai parametri di prestazione accettati, nella vista di analisi dei dati all'interno 
dell'applicazione ChemStation, selezionare View > Verification > Run Test (Vista > 
Verifica > Esegui test). Il test di verifica del sistema viene avviato 
automaticamente.

• Selezionare Run Test (Esegui test) dalla Verification View (Vista di verifica) ed 
eseguire la procedura del test di verifica denominata default.val.

• Per ulteriori informazioni, consultare la sezione della Guida in linea 
relativa ai processi analitici.
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Questo capitolo fornisce una panoramica sulle risorse aggiuntive della 
ChemStation Agilent reperibili nel DVD della ChemStation Agilent e 
all'indirizzo www.agilent.com/chem.
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Centro Servizi Clienti Agilent Technologies 

I servizi di assistenza aiutano a risolvere i problemi e a ottimizzare 
le prestazioni

La rete Agilent dei Centri Servizi Clienti consente l'accesso a un supporto 
professionale che aiuta a risolvere le difficoltà operative e offre assistenza 
e suggerimenti per utilizzare al meglio il software analitico Agilent. 
Tradizionalmente, questo supporto viene fornito telefonicamente, ma è anche 
possibile estenderlo, se richiesto, a un supporto a distanza via modem. 

Il supporto per il software è disponibile per il primo anno e può essere esteso 
per altri due anni a tariffe estremamente competitive. Tale supporto 
garantisce l'assistenza telefonica, gli aggiornamenti di revisione del software 
al momento del rilascio e il regolare invio dei Software Status Bulletin 
contenenti importanti informazioni sui problemi conosciuti e sulle possibili 
soluzioni per il software analitico Agilent. Per ulteriori informazioni su come 
abbonarsi a questi servizi rivolgersi alla sede Agilent Technologies più vicina.

Il rappresentante Agilent può inoltre fornire informazioni su tutti i servizi 
disponibili: consulenza, personalizzazione, sviluppo e addestramento per 
prodotti software analitici Agilent.

I servizi di supporto e aggiornamento forniti da Agilent sono soggetti alle 
tariffe, ai termini e alle condizioni vigenti nel paese al momento dell'ordine.
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Contattare il Centro Servizi Clienti Agilent Technologies

Prima di chiamare il centro di assistenza clienti Agilent Technologies, 
posizionarsi davanti al computer e verificare di avere a disposizione 
la documentazione sul prodotto.

Sono generalmente necessarie le seguenti informazioni:

• L'etichetta del pacchetto di registrazione con il numero del prodotto, 
il codice della versione e il numero di registrazione della licenza relativa 
al software analitico

• La dicitura esatta di qualsiasi messaggio di errore visualizzato dal sistema

• Una stampa completa di Windows System Information

• Una descrizione della situazione che ha provocato il problema.
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Contenuto del DVD della ChemStation Agilent

Il DVD della ChemStation Agilent contiene informazioni supplementari 
aggiornate che potrebbero rivelarsi interessanti al momento dell'installazione 
del sistema. In caso di necessità, fare riferimento alle seguenti informazioni 
supplementari.

Moduli della ChemStation Agilent

Il DVD contiene file eseguibili per tutti i moduli che appartengono alla famiglia 
di prodotti della ChemStation Agilent. Per installare un modulo è necessario 
immettere il numero di licenza valido per il modulo, che consente di sbloccare 
il DVD protetto. I numeri di licenza sono contenuti nel prodotto originale 
e comprovano l'acquisto della licenza.

Per l'installazione iniziale del moduli della ChemStation Agilent, è disponibile 
un collegamento al programma di installazione (setup.exe) nella directory 
principale del DVD della ChemStation Agilent. Successivamente sarà possibile 
installare moduli aggiuntivi selezionando Start > Programmi > Agilent 
ChemStation > Add Instrument.

Bollettino sullo stato del software della ChemStation Agilent

Il Software Status Bulletin (SBS) è un documento che riporta i risultati di 
ricerche effettuate da Agilent su eventuali difetti, relativa registrazione, 
controllo e metodologia di riparazione. Il bollettino SSB si trova nella 
directory Support\SSB del DVD della ChemStation Agilent.

Se si è sottoscritto un contratto per il software, si riceverà il Software Status 
Bulletin della ChemStation Agilent.

Storico delle revisioni della ChemStation Agilent

Lo storico delle revisioni si rivolge ad utenti che potrebbero dover considerare 
una nuova validazione del sistema di gestione dei dati analitici in seguito 
all'aggiornamento del software applicativo. Lo storico delle revisioni interessa 
tutti i prodotti che fanno parte della famiglia ChemStation Agilent.

I file storici si trovano nella directory Support\History del DVD della 
ChemStation Agilent.

Nel primo argomento della Guida in linea è presente un riepilogo delle modifiche.
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User-contributed library (Raccolta di contributi degli utenti)

Il contenuto di questa raccolta ha lo scopo di aiutare gli utenti a sviluppare 
e personalizzare le installazioni in funzione di specifici requisiti e a ottenere 
i migliori risultati dal loro investimento.

La raccolta è stata creata con fonti interne Agilent e grazie ai contributi degli 
utenti. Ogni contributo è stato controllato nella sua funzionalità, ma non 
necessariamente sottoposto a tutti i test formali con cui sono collaudati 
i prodotti effettivi. Di conseguenza, Agilent Technologies non può garantire 
la loro correttezza.

La User-Contributed Library comprende utilità e macro. Ogni contributo 
è corredato da un file di spiegazioni (README.TXT) che può essere esaminato 
con qualsiasi editor di testo.

Librerie di I/O per l'interfaccia GPIB Agilent

Il DVD della ChemStation Agilent contiene la versione di librerie di I/O 
verificate con successo con questa versione della ChemStation Agilent. 
L'installazione delle librerie di I/O deve essere eseguita separatamente per 
gli strumenti GPIB, come descritto nella guida separata Agilent IO Libraries 
Suite 15.0 or higher Installation and Configuration Instructions (Istruzioni 
di installazione e configurazione di Agilent IO Libraries Suite 15.0 o 
successive).

Servizio BootP Agilent

Il DVD della ChemStation Agilent contiene un file di impostazione del Servizio 
BootP Agilent che può essere utilizzato per fornire agli strumenti analitici 
collegati a una LAN un indirizzo IP e impostazioni per la configurazione. Il 
Servizio BootP Agilent può essere facilmente configurato e utilizzato con gli 
strumenti analitici che utilizzano una connessione LAN. Consultare la sezione 
"Installazione del Servizio BootP Agilent" a pagina 17 per ulteriori 
informazioni sul servizio BootP.

Documentazione relativa al prodotto ChemStation Agilent

La documentazione relativa alla ChemStation Agilent consiste di manuali 
stampati contenenti informazioni di riferimento e documentazione in linea su 
soggetti di utilizzo pratico. Versioni elettroniche di tutti i manuali della 
ChemStation si trovano anche nella directory dei manuali del DVD.
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Prodotti di apprendimento

Con il software della ChemStation Agilent, del PC e degli strumenti, vengono 
forniti numerosi prodotti per l'apprendimento. 

Documenti

• Questo e altri manuali di installazione descrivono come preparare la 
ChemStation Agilent per l'attività, installando hardware e software 
necessari. I manuali di installazione sono specifici per i vari moduli che 
possono essere incorporati nella ChemStation Agilent. Il sistema fornito 
può comprendere più di un manuale.

• Il manuale Understanding Your ChemStation (Introduzione alla 
ChemStation) tratta i concetti su cui si basa la ChemStation Agilent, 
atti a fornire una maggiore comprensione del suo funzionamento.

• La guida in linea Macro Programming (Programmazione macro) descrive 
come utilizzare il potente set di comandi disponibile per personalizzare ed 
espandere le capacità della ChemStation Agilent. Per accedere a questa 
guida, scegliere Commands (Comandi) dal menu Help (Guida).

• L'interfaccia XML è completamente documentata nel manuale Agilent 
ChemStation XML Plus Connectivity Guide (Guida alla connettività XML 
Plus della ChemStation Agilent) disponibile in formato PDF nella directory 
dei manuali del DVD della ChemStation Agilent.

Informazioni sulla manutenzione e la configurazione pertinente

• Il file README contiene informazioni sull'aggiunta di nuove funzioni, 
soluzioni conosciute e correzioni che non è stato possibile documentare in 
questo manuale prima che fosse stampato. Per accedere al file readme.txt, 
selezionare Start > Programmi > Agilent ChemStation > readme.txt.

• Il Logbook (Registro elettronico) aggiornato automaticamente contiene 
qualsiasi eventuale condizione di errore rilevata durante il funzionamento 
e, se richieste, le azioni correttive pertinenti. Per accedervi, scegliere 
Logbook dal menu View (Visualizza), quindi fare doppio clic sulle voci. 
Le voci più recenti sono le prime dell'elenco.
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Guida della ChemStation Agilent

La Guida della ChemStation Agilent mette a disposizione un database di 
informazioni molto ampio, strutturato nelle seguenti voci di menu:

• ChemStation Tutorial (Addestramento alla ChemStation) contiene una 
panoramica sul software e sulle attività comuni che aiuterà a comprendere 
i principi fondamentali del sistema.

• How to work with your ChemStation (Come lavorare con la ChemStation) 
contiene una serie di istruzioni applicabili alla ChemStation Agilent. Si può 
apprendere come eseguire le attività per il controllo del metodo e delle 
analisi, per l'analisi dei dati, per impostare il layout dei rapporti, per 
eseguire le verifiche (OQ/PV) e per sfruttare le caratteristiche di 
visualizzazione della diagnosi.

• User Interface Reference (Riferimento per l'interfaccia utente) contiene 
una descrizione dettagliata di tutte le voci di menu, delle barre degli 
strumenti e delle finestre di dialogo del software della ChemStation Agilent. 
Le descrizioni sono ordinate in base alle varie visualizzazioni della 
ChemStation Agilent. 

• Concepts of ChemStation (Concetti sulla ChemStation) contiene informazioni 
su una serie di concetti selezionati relativi al software della ChemStation 
Agilent, tra cui l'integrazione, la calibrazione, i tipi di rapporto sulle 
calibrazioni, l'elaborazione degli spettri e i parametri dei picchi.

• Error Messages (Messaggi di errore) contiene un elenco di tutti i possibili 
messaggi di errore degli strumenti, delle possibili cause e delle azioni 
correttive. 

• Troubleshooting (Risoluzione dei problemi) fornisce informazioni che 
possono aiutare a risolvere eventuali problemi comuni incontrati nell'uso 
della ChemStation Agilent.

• Commands (Comandi) contiene un vasto elenco di comandi e di nomi, 
gruppi, sintassi, parametri, commenti, valori restituiti e, quando possibile, 
esempi di varie attività nel software della ChemStation Agilent.

• Macros (Macro) contiene la Macro Programming Guide (Guida alla 
programmazione macro) in cui è spiegato lo scopo, la struttura base di una 
macro e il modo in cui è possibile scrivere una macro utilizzando stringhe di 
comandi. Le macro consentono di personalizzare il software della 
ChemStation Agilent secondo le proprie esigenze.



66 Installazione della ChemStation

5 Risorse supplementari

Software Agilent Lab Advisor

Nel software Agilent Lab Advisor è disponibile un'ampia raccolta di 
informazioni in linea, video, manuali e molte altre informazioni.

Il software Agilent Lab Advisor si presenta come un approccio integrato per 
i laboratori moderni. Oltre a fornire video e documentazione relativa 
all'hardware, tale software offre le seguenti funzioni:

• Monitoraggio di più strumenti analitici in tempo reale

• Registrazione delle operazioni di manutenzione di routine

• Avviso in caso di eventuali aree che necessitano assistenza prima che si 
verifichino i problemi

• Esecuzione di test diagnostici di verifica e calibrazione.

Ulteriori informazioni

Per ulteriori informazioni, visitare il sito Web Agilent all'indirizzo 
www.agilent.com/chem.
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